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Notes on Safety This manual does not constitute a complete catalogue of all safety measures required for 
operating the respective equipment (module, device), since special operating conditions 
may require additional measures. However, it does contain notes which must be adhered 
to for your own personal safety and for avoiding property damage. These notes are high-
lighted with a warning triangle and different keywords indicating different degrees of dan-
ger:

Warning

means that death, severe injury or substantial property damage may occur if the appropri-
ate safety measures are not taken.

Caution

means that minor injury or property damage may occur if the appropriate safety measures 
are not taken.

Qualified Personnel

Commissioning and operation of the equipment (module, device) described in this manual 
must be performed by qualified personnel only. In the sense of the safety notes contained 
in this manual, qualified personnel are those persons who are authorized to commission, 
release, ground and tag devices, systems and electrical circuits in accordance with safety 
standards.

Use as Prescribed

The equipment (device, module) must not be used for any other purposes than those 
described in the Catalog and the technical description. If it is used together with third-party 
devices and components, these must be recommended or approved by Siemens.

Correct and safe operation of the product requires adequate transportation, storage, instal-
lation and mounting as well as appropriate use and maintenance.

During operation of electrical equipment, it is unavoidable that certain parts of this equip-
ment are carrying dangerous current. Severe injury or property damage may occur if the 
appropriate measures are omitted:

• Before making any connections at all, ground the equipment at the PE terminal.

• Hazardous voltages may be present on all switching components connected to the 
power supply.

• Even after the supply voltage has been disconnected, hazardous voltages may still be 
present in the equipment (capacitor storage).

• Equipment with current transformer circuits may not be operated while open.

The limit values indicated in the manual or the operating instructions must not be exceeded; 
this also applies to testing and commissioning.
Siemens Aktiengesellschaft Document No. E50417-H1076-C265-A2

Disclaimer of liability
Although we have carefully checked the contents of this publication 
for conformity with the hardware and software described, we cannot 
guarantee complete conformity since erorrs cannot be excluded. 
The information provided in this manual is checked at regular inter-
vals and any corrections which might become necessary are includ-
ed in the next releases. Any suggestions for improvement are 
welcome.

The contents of this manual is subject to change without prior 
notice.
Document version: 2.30.01

Copyright
Copyright  Siemens AG 2006 All Rights Reserved
This document shall not be transmitted or reproduced, nor shall its 
contents be exploited or disclosed to third persons without prior 
written consent from Siemens. Infringements shall entitle to dam-
age claims. All rights reserved, in particular in case of a patent grant 
or utility model registration.
 
Registered Trademarks
SIMEAS Q® and SICARO Q® are registered  trademarks of 
SIEMENS AG. All other product and brand names in this manual 
may be trademarks, the use of which by third persons for their pur-
poses may infringe the rights of their respective owners.

http://siemens-russia.com/


Foreword

This manual describes the functions of the SIMEAS Q device and the 
SIMEAS Q Par V2.30 software. The manual is intended for users of 
SIMEAS Q.

Scope of validity of 
the manual

This manual is valid for SIMEAS Q Par V2.30 and higher.

This version is suitable for SIMEAS Q devices of the generation 2 work-
ing with firmware version 2.30.

Standards SIMEAS Q was developed in compliance with the ISO 9001 standards.

Further support For general information and questions regarding licences please contact 
your local Siemens sales partner.

Hotline Questions regarding SIMEAS Q Par V2.30 and SIMEAS Q will be 
answered by our Hotline in Nuremberg:

Siemens AG 
Customer Care Center
Humboldtstr. 59
D-90459 Nuremberg

Telephone +49 (0)180 / 5247000
Fax +49 (0)180 / 5242471
E-Mail ptd.services@siemens.com

Downloadarea Information concerning Power Quality products as well as firmware and 
software downloads are available at our Internet download area:

www.powerquality.de or

www.simeas.com
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Product Overview 1
General 
information 

SIMEAS Q Par V2.30 is a software for the configuration of SIMEAS Q 
according to your requirements. Depending on the used communication 
protocol (RS232, RS485 and PROFIBUS DP) the software enables the 
configuration and preparation of the SIMEAS Q for operation.

Functionality The software SIMEAS Q Parameterization enables the following func-
tions:

Definition of the device address

Definition of the communication parameter, e.g. transfer rate setting

Calibration of the device

Update the device address

Parameterizing of measurement setting of SIMEAS Q
1SIMEAS Q Par Manual
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Setting up the Software 2
Overview See the following for information on the setup of the SIMEAS Q Par 

V2.30 software.

Contents 2.1  Software requirements  4

2.2  Hardware requirements  5

2.3  Installation  6
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Setting up the Software
2.1 Software requirements

SIMEAS Q Par V2.30 is a 32-bit-application which is executable under 
the following operating systems:

Windows XP Professional incl. Service Pack 2
4 SIMEAS Q Par Manual
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2.2 Hardware requirements

The SIMEAS Q Par V2.30 software can be installed on all IBM-compati-
ble computers that fulfil the following minimum requirements:

The computer must comply with the hardware requirements of the 
operating sytem used.

Free serial interface

Note:

For the transmission of the parameter a special communication cable is 
necessary. Please use the cable which is in the scope of supply of con-
figuration package.
5SIMEAS Q Par Manual
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Setting up the Software
2.3 Installation

You can install the SIMEAS Q Par V2.30 software using a setup pro-
gram. The software is neither protected by a dongle nor do you have to 
enter a registration number. 

Installation of the 
software

Proceed as follows: 

Insert the installation CD into your CD-ROM drive. The installation pro-
cess is started.  

Follow the installation instructions. 

Note:

You require administrator rights for installing the software.

Note:

If the installation process is not started automatically, proceed as follows: 

• Click Start → Run.

• Enter X:\SETUP.EXE, with X designating the letter of your CD-ROM 
drive. 

• Click OK. 
6 SIMEAS Q Par Manual
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Getting Started 3
Overview This chapter Getting Started describes how to install the parameteriza-

tion software including starting up the device. Changes to the default 
parameters are only described if they are necessary to adapt the device 
to the existing system environment. A detailed description of the various 
functions and parameters is given in Chapter 4 of this manual.

The sequence of operations described is not mandatory, but is intended 
to help you become familiar with parameterization of the SIMEAS Q.

Contents 3.1  Starting SIMEAS Q Par V2.30  8

3.2  Connecting the SIMEAS Q and PC  17

3.3  Setting up the parameterization interface on the PC  19

3.4  Selecting the parameterization mode  20

3.5  Receive Identification  21

3.6  Setting the device address  23

3.7  Synchronizing the SIMEAS Q  25

3.8  Receive, edit and send connection settings  26
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Getting Started
3.1 Starting SIMEAS Q Par V2.30

3.1.1 Calling up and terminating the program

Call-up After you have successfully installed SIMEAS Q Par, you can run the 
program as follows:

Double-click on the program icon on the Windows desktop. The main 
window of the program is opened.

Image3_01.giff

Fig. 3-1 Main window of SIMEAS Q Par

After you have started the program, the default data set is loaded in 
accordance with standard EN 50160. This data set is displayed as 
Untitled in the titlebar and is taken as a basis for creating parameter data 
sets.

Exiting This is how to exit the program.

Select menu item File → Exit. The program is terminated and you return 
to the Windows desktop.

Note:

If you have made changes to the data set currently loaded, a reminder is 
displayed which you must confirm.
8 SIMEAS Q Par Manual
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3.1.2 User interface 

The user interface of the SIMEAS Q Par software complies with Win-
dows conventions. It is subdivided into the following parts:

Image3_02.gif

Fig. 3-2 User interface of the SIMEAS Q Par

Titlebar In the titlebar, the parameterization file currently loaded and the name of 
the software are always displayed. After you have started the program, 
they will be:

Untitled - SIMEAS Q Par V2.30

Menubar The user interface is subdivided into six main menus which each contain 
menu items for related functions.

Titlebar
Menubar
Toolbar

Data Area

Statusbar
9SIMEAS Q Par Manual
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Getting Started
Toolbar The toolbar contains icons for frequently required functions. Each icon is 
associated with a function which is called up when you click on the icon. 

Image3_03.gif

Fig. 3-3 Icons of the functions on the toolbar

Data area In the data area, the dialog boxes of the program are displayed.

Statusbar The statusbar shows short explanations of each function.

Show measurement 
values

Calibrate

Send parameters

Parameterize measurement settings

Receive parameters

Print 

Save

Open

New
10 SIMEAS Q Par Manual
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3.1.3 Main menus 

This section gives brief explanations of the function groups in each main 
menu to provide you with an overview of the user interface. A reference 
to the relevant section is given for functions that require a detailed 
description. 

File menu This contains functions for managing files. The names and functions of 
the menu items comply with Windows conventions.

Image3_04.gif

Fig. 3-4 Functions of the File menu 

Device menu Contains functions referring to parameterization of the SIMEAS Q. 

Image3_05.gif

Fig. 3-5 Functions of the Device menu
11SIMEAS Q Par Manual
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Getting Started
Connection menu Includes functions resp. menus for configuration of the device connec-
tion.

Image3_06.gif

Fig. 3-6 Functions of the Connection menu

View menu Contains functions that change the appearance of the software on the 
screen. You can have the icon and/or the statusbar displayed or hidden.

Image3_07.gif

Fig. 3-7 Functions of the View menu

Extras menu Includes language settings as well as functions that concern the system 
settings.

Image3_08.gif

Fig. 3-8 Functions of the Extras menu

Help menu Contains help topics and information about the software version.

Image3_09.gif

Fig. 3-9 Functions of the Help menu
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3.1.4 Selecting the language of the user interface 

At present, it is possible to switch the user interface of the program 
between four languages, German, English, French, and Spanish. The 
new user interface language is always automatically stored permanently 
until you change the language again, i.e. the other storage functions of 
the program do not have any effect on it. 

This is how you change the user interface language:

Select the menu item Extras → Language. The Language dialogue box 
is opened.

Open the dropdown list and click on English. The selected language is 
placed in the dropdown list box.

Image3_10.gif

Fig. 3-10 Setting the language

Confirm with OK. An information box indicates that the newly selected 
language will only be activated the next time you run the program.

Confirm with OK and exit the program.

Image3_11.gif

Fig. 3-11 Message box

Note:

The default setting for the user interface language is German.
13SIMEAS Q Par Manual
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Getting Started
3.1.5 Operating with File menu 

Creating a new 
parameter file 

After launching the software SIMEAS Q Par a standard parameter set 
will uploaded. The name of this standard set is Untitled and will repre-
sented in the titlebar. 

To create a new parameter file, select menu File → New or click on 
the New icon in the toolbar.

Image3_12.gif

Fig. 3-12 Creating a new parameter file

Opening a already 
saved parameter 
file

To open a already saved parameter file, select the menu File → 
Open... or click on the symbol Open in the toolbar of the software.

Image3_13.gif

Fig. 3-13 Opening a parameter file

Afterwards the dialogue box Open opens, Select the parameter file 
to be opened and confirm your choice with Open.
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Image3_14.gif

Fig. 3-14 Selecting and opening a parameter file

Saving the parame-
ter file

To save a parameter file and to reuse it, e.g., for other SIMEAS Q 
devices you select the menu item File → Save or click on the Save 
icon in the toolbar.

Image3_15.gif

Fig. 3-15 Saving the parameter file

To save a parameter file under a new name select the menu 
File → Save as. 

Note:

The Parameter files are saved as files with the extension .*sqd. With the 
SIMEAS Q Parameterization software only files of this format can be 
read.
15SIMEAS Q Par Manual
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Getting Started
Image3_16.gif

Fig. 3-16 Save As menu

Select the file name and the directory in which you want to save the 
parameter file. 

Image3_17.gif

Fig. 3-17 Dialog box Save As

Printer Setup Under the menu File → Printer Setup you can select an installed 
printer with which you can print out the device settings.

Print Preview With the menu File → Print Preview you can open the print preview 
including the device settings.

Print With the menu item File → Print you can print out the current loaded 
device settings with a connected printer.
16 SIMEAS Q Par Manual
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3.2 Connecting the SIMEAS Q and PC

To establish a connection to a SIMEAS Q, for transmission of the meas-
urement settings the SIMEAS Q has to be connected to a PC. For that, 
you require the specific connecting cable included in the scope of supply 
of the parameterization package. It consists of:

2 cables

Gender changer

RS232 - 485 converter 

5V power supply unit

Assembling the 
connecting cable 

The connecting cable is assembled as shown in the drawing in Fig. 3-18.

cable.gif

Fig. 3-18 Structure of the connecting cable

SIMEAS Q
end

Converter

Gender
changer

PC end

RS 485

RS 232

5V

Power sup-
ply unit
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Getting Started
Connecting the 
connecting cable

 

Check the connection. If you have connected the connecting cable the 
wrong way round, no parameterization data will be transmitted.

Connect the 5 V power supply unit to a 220 V power source.

Caution:

Do not connect the wrong 9-way SubD connectors! The RS485 end must 
be connected to the SIMEAS Q and the RS232 end with the PC!
18 SIMEAS Q Par Manual
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3.3 Setting up the parameterization interface on the PC 

In this section, you will set the serial interface via which you will load the 
parameter data set into the SIMEAS Q. Proceed as follows:

Select menu Connection → Set device connection. The Set device 
connection dialog box will open.

Select from the dropdown list the entry Direct connection from the 
overall parameterization.

Afterwards select the interface on which you have connected the 
device.

Choose the option: RS485-Converter reflecting data, if you use a 
reflecting converter. 

Confirm your settings with OK.

Image3_19.gif

Fig. 3-19 Setting up the parameterization interface

Note:

If you use the standard converter included in the parameterization 
packet, this function must be active.
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Getting Started
3.4 Selecting the parameterization mode 

After Power On, SIMEAS Q remains in parameterization mode for 
2 minutes. After that, it automatically switches to recording mode and 
remains in recording mode.

The following applies:

If a parameterization telegram is received within the first 2 minutes, the 
SIMEAS Q remains in parameterization mode. To switch to recording 
mode, you have to switch off the SIMEAS Q and switch it on again. After 
2 minutes, it will then switch to recording mode.

If no parameterization telegram is received within the 2 minutes, SIMEAS 
Q switches to recording mode and remains in recording mode. To switch 
back to parameterization mode, you must switch off the SIMEAS Q and 
switch it on again. It is then in parameterization mode for 2 minutes.

Procedure

To set the SIMEAS Q device into the parameterization mode select the 
function Receive Identification. This function will be described in the fol-
lowing. 
20 SIMEAS Q Par Manual
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3.5 Receive Identification 

After you have connected the PC with the SIEMAS Q and also configured 
the communication you can try to communicate with the device for the 
first time.

Select menu item Device → Receive Identification within the next 2 
minutes. The Receive identification communication box is opened.

Image3_20.gif

Fig. 3-20 Receive identification communication box (1)

Click on the Receive identification button. A parameterization telegram 
is sent.

Image3_21.gif

Fig. 3-21 Receive identification communication box (2)

Note:

To receive the identification the device must be connected to a power 
supply and turned on. 
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Getting Started
Click on the Close button to return to the main window.

Note:

By calling up this function the device will switch in parameterization 
mode. It remains in this mode as long as a new start happens.
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3.6 Setting the device address 

To identify the SIMEAS Q in the communication network a unique device 
address has to be assigned.

Select menu item Device → Set device address. The Set device 
address dialogue box is opened. 

Image3_22.gif

Fig. 3-22 Set device address menu

Enter the address which you would like to assign to the device.
 

Image3_23.gif

Fig. 3-23 Set device address

Note:

Please mind that you do not use a device address twice in your commu-
nication network.
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Getting Started
 

Click on the Send address button.

Close the window with Close. You have now transferred the PROFIBUS 
address to the device.

Note:

If you would like to operate the SIMEAS Q in a PROFIBUS DP system 
please ask the PROFIBUS system administrator which address you 
should use for the device.
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3.7 Synchronizing the SIMEAS Q 

To synchronize the SIMEAS Q, set the date and time to your system 
time. 

Select menu item Device → Set SIMEAS Q clock. The Set 
SIMEAS Q clock dialogue box opens.

Click on the Send PC time button. Your PC sends its time data to the 
SIMEAS Q and synchronizes its own internal clock with the PC time. 

Click on the Close button to return to the main window.

Image3_24.gif

Fig. 3-24  Set SIMEAS Q Clock communication box
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Getting Started
3.8 Receive, edit and send connection settings

Configure connec-
tion settings

To transfer measured values from the device to your evaluation-PC the 
connection settings have to be configured first.

Receive connection 
settings

To edit the current device settings you have to transmit them from the 
device in the following way:

Select the menu Device → Receive connection settings

Image3_25.gif

Fig. 3-25  Receive connection settings menu

Afterwards the connection parameters will be transmitted from the device 
to your PC.

After the successful transmission of the settings the following message 
appears.

Image3_26.gif

Fig. 3-26  Connection parameters transferred

Edit connection 
settings

To edit the connection settings please proceed as follows:

Select the menu Device → Edit connection settings
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Image3_27.gif

Fig. 3-27  Edit connection settings menu

Afterwards the following dialog window a opens:

Image3_28.gif

Fig. 3-28  Edit connection settings 

Password
we recommend to keep the pre-setting.

Baudrate
Select the transfer rate e.g. 115.200 Bit/sec. 

Connection type
Depending how you want to connect the SIMEAS Q with you evalua-
tion-PC, you have the possibility to select 2 different types of connec-
tion. Either you use a Modem or direct connection for communication.

Note:

If you use long distance communication cable a high transfer rate might 
not work. In this case select a lower transfer rate.
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Modem
Select this type of connection if you want to communicate with the 
SIMEAS Q via a modem. We recommend to use the init string: 
ATQ0V1M0X3S0=1^M.

Direct connection
Select this type of connection if you want to communicate with the SIM-
ESA Q via a direct connection.

Confirm your selection with OK.

Send connection 
settings

To transmit the connection settings to the device proceed as follows:

Select the menu Device → Send connection settings. Afterwards the 
settings will be transmitted to the device.

Image3_29.gif

Fig. 3-29  Send connection settings menu 

After successful transmission confirm the message with OK.

Image3_30.gif

Fig. 3-30  Connection parameters transferred

Note:

A communication via a modem is only possible for SIMEAS Q with 
RS232 (7KG8000-8B*20) or RS485 (7KG8000-8C*20) interface.
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3.8.1  Function test 

The function test shows whether your SIMEAS Q is functional and 
whether it has been calibrated properly. Proceed as follows:

Connect the current and voltage source, preferably with the nominal 
values of your measuring range, to the inputs of your SIMEAS Q.

Select menu item Device → Show measurement values. The Show 
measurement values dialog box opens and the measurement val-
ues are displayed. 

Click on the Close button to terminate display of the measurement 
values.

Image3_31.gif

Fig. 3-31 Show measurement value communication box 

Caution:

Assuming the SIMEAS Q is correctly calibrated, the current and voltage 
values displayed must match the input values applied. A variation of 
± 0.1% from the end value of the measuring range, i.e. ± 0.28 V for volt-
ages and ± 0.006 A for currents is permissible.

If the values applied and the values displayed do not match taking the 
permissible tolerance into account, you should recalibrate the device 
(see Chapter 5.1).
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3.8.2 Restart

After you have configured all parameters, the SIMEAS Q has to be 
brought into operation mode. To do this 2 options are available.

1. By selecting the menu Device → Restart the device will be brought 
into operation mode. This function takes at least up to 2 minutes and 
will be indicated with a status information.

Image3_32.gif

Fig. 3-32 Communication window Show measurement value 

2. The second possibility is to disconnect the device for a couple of sec-
onds form the auxiliary power supply.

 After 2 minutes the device changes into operation mode.

Note:

The device is in operation mode, only when the left green LED is on.
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Parameterization 4
Overview This chapter Parameterization describes how to parameterize the 

measurement settings from defining the network properties to transfer-
ring the completed parameter set to SIMEAS Q. 

The selected sequence is useful, but not obligatory. It is possible to 
switch between any input windows. The measured quantities that you 
can select are provided by SIMEAS Q Par depending on the type of net-
work set. Therefore always define the type of network first before starting 
to parameterize the measured quantities.

Contents 4.1  Parameterizing measurement settings (overview)  32

4.2  Entering measurement settings  34

4.3  Defining basic settings  36

4.4  Activating measured quantities with cont. measurement  46

4.5  Activating measured quantities for fault value measurement  50

4.6  Transferring parameters  53

4.7  Mounting the device  55
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Parameterization
4.1 Parameterizing measurement settings (overview) 

SIMEAS Q records measured quantities either continuously or depend-
ing on events, measured value violations with time stamp. With continu-
ous measurement, the extreme values of each measured quantity can be 
stored within a defined period. Both recording modes are available at the 
same time. All measured quantities are acquired simultaneously in par-
allel.

The device is parameterized before use using the SIMEAS Q Par soft-
ware. During parameterization, you select all the required measured 
quantities and define the recording mode for each measured quantity. 
You can perform up to 200 measurements at the same time with 
SIMEAS Q.

Continuous 
recording 

With continuous recording, you can define measuring periods (averaging 
times) for the selected measurement variables. Within such a period, a 
mean value is determined for the measured quantity from the acquired 
value. The mean value and the time information about the end of the 
measuring period is stored in the memory.

Recording 
of faults 

The recording of faults is mainly used to record voltage dips or overvolt-
ages. Measured data are only recorded if the average value of a variable 
has violated one or more upper or lower limits (threshold values). The 
mean value between two limit value violations and the time it occurred 
are also stored.

Calculation of the
measured data 

During measuring and recording operation, the device calculates the 
RMS value over a sine half wave (half period) for each activated voltage 
and current channel. The required variables are calculated from the scan 
values according to the parameterization.

Note:

You will find the basis for calculating the individual values in Appendix A.
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Possible measured 
quantities 

With SIMEAS Q, you can store and read up to 200 different measured 
values. Compared with conventional network quality recorders that can 
be read out via PROFIBUS, this is a considerable improvement.

You can acquire, monitor, or calculate the following variables:

RMS values of the phase-to-phase voltages

RMS values of the phase-to-phase currents

Line frequency

Active, reactive, apparent power and power factor per phase and for the 
entire system

Balance factor of the currents and voltages

Flicker interference factors for short term and long term per phase

Harmonic voltages and currents per phase
up to the 40th harmonic

Total harmonic distortion THD per phase

Active work (input and output), 
reactive work (capacitive and inductive) 
and apparent work of the entire system.

Calling up 
data sheets 

The measurement settings are input via data sheets. These contain all 
the relevant measurement quantities for the selected measurement set-
tings. Opening these data sheets is described in Chapter 4.2.
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4.2 Entering measurement settings 

4.2.1 Calling up data sheets 

Measurement settings are entered on data sheets. Data sheets contain 
all the parameters relevant to the selected measurement settings.

Select menu item Device → Edit measurement settings. The Param-
eterize measurement settings box is opened. 

It is divided into two areas: 

The navigation window (left) 

The data window (right).

Image4_01.gif

Fig. 4-1 Navigation and data windows of the Parameterize measurement 
settings function

Navigation window The navigation window contains a hierarchical structure like the Windows 
directory structure. This makes the menu structure of the program clearer 
and enables you to navigate through the various data sheets of the 
measurement settings quickly. 

The measurement settings are divided into three groups:

Basic settings

Continuous recording

Recording in the event of faults
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Each group branches further into the level of the data sheets. These lev-
els are first hidden. You can make them visible or invisible as follows:

Double-click on the plus sign in front of the name of the group. The hid-
den level becomes visible and the plus sign turns into a minus sign.

Double-click on the minus sign in front of the name of the group. The 
visible level becomes invisible and the minus sign turns into a plus sign.

Data group At first, the data window shows an explanatory text about the group which 
is marked. Only when you have opened a data sheet are the parameters 
for the measurement settings in question displayed. Data sheets are 
marked by a circle symbol in front of the name. 

This is how to open a data sheet:

Click once on the icon or the name of the data sheet in the navigation 
window. The data sheet is displayed in the data window.

Data sheets The data sheets are preset to the values of the default data set Untitled. 
These preset measurement settings correspond to the mean values of 
the value ranges recommended in the EN 50160 standard.  

Note:

The measurement settings of the default data set are listed in Appendix B.
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4.3 Defining basic settings 

Before you select and parameterize measured quantities, you must set 
the parameter set to the network to be measured and define the meas-
urement conditions and calculation methods. 

Measured 
quantities

You can set these under Basic settings in the navigation window. The 
basic settings include the following parameters and measured quantities:

Network settings

Nominal frequency of the power supply network (50 or 60 Hz)

Network type (single-phase system, three-wire network, four-wire net-
work)

Nominal voltage

Transformer ratio of the primary transformer, if necessary 
(/1/ SIMEAS Q, Operating Instructions)

Function of the two relay outputs 
(binary output 1 or binary output 2)

Other settings

Calculation of the flicker interference factor in A or P values

Definition of the time base for acquiring max and min values

Definition of the period for recording measured values

Selection of the storage mode
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4.3.1 Network settings 

If you select Network settings in the navigation window (under Basic 
settings), the dialog for defining these parameters is opened in the data 
window.

Image4_02.gif

Fig. 4-2 Dialog box for setting the network parameters

You can change the defined network data at any time to adapt 
SIMEAS Q flexibly to other networks (measurement environments).

Select the radio buttons of the network data that define your network.

50 Hz or 60 Hz as the nominal frequency 

Single-phase system, 3 wire network - Delta, 4 wire network - Star as 
network type

Note:

The SIMEAS Q is preset for measurements in a four-wire network with 
50 Hz and 230 V (LP - N). 

Warning:

Restart your SIMEAS Q device after each change of the network 
frequency setting.

SIMEAS Q uses different scanning frequencies for 50 and 60 Hz. To 
obtain precise measuring results, the SIMEAS Q should be calibrated at 
the network frequency used later during the measurement. 

The Receive identification function displays the network frequency to 
which the measured-value capturing is being synchronized. 
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The SIMEAS Q device can capture measured values either as 
primary or as secondary values. The measured variables are usually 
scanned at a voltage transformer. Specify the transformer ratio to be 
able to capture primary values. To capture secondary values, select 
the Without transformer option. This option must also be selected 
for the direct voltage measurement, e.g. in the 230 V network. On the 
input side, the SIMEAS Q can measure voltages in a range from 0 to 
280 V.
If you have selected Without transformer, you must additionally 
specify the nominal voltage. The maximum value which can be 
specified is 280 V. At any rate, you must indicate phase-ground 
voltages. For a direct measurement in the 230 V network, the nominal 
voltage is 230 V. For a measurement with voltage transformers, the 
nominal voltage is in most cases 100/root 3 (57.74V) or 110/root 3 
(63.5 V). 
If you select the With transformer option, the transformer ratio on the 
primary side can be indicated in a range from 0.1 to 1000 kV and on 
the secondary side in a range from 0 to 280 V. 
Attention: The secondary voltage must always be specified in kV! 
The entry the field Nominal voltage is used as calculation basis for 
SICARO PQ. 

Like for the voltages, the SIMEAS Q device is also able to capture 
currents in primary or secondary values. The transformer ratio of the 
current transformer must be specified accordingly. 
On the input side, SIMEAS Q can measure currents in a range from 0 
to 6 A. If the Without transformer option is selected, SIMEAS Q 
captures measured values in this range. 
On the primary side, the transformer ratio can be indicated in a range 
from 1 to 100,000 A whereas on the secondary side, it can be 
indicated in a range from 0 to 6 A. The secondary transformer output 
usually is 1 or 5 A. 
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4.3.2 Binary outputs 

SIMEAS Q is equipped with two binary outputs implemented by means 
of optocoupler relays. The switching information available in this way can 
be used with other devices such as recorders, horns, sensing elements 
or pulse recorders. 

You can allocate predefined functions to the binary outputs indepen-
dently of each other.

Image4_03.gif

Fig. 4-3  Binary output data sheet

Default setting The default is SIMEAS Q active for binary output 1 and Voltage dip for 
binary output 2.

To change these settings, proceed as follows:

Select Binary output 1 or Binary output 2 under Basic settings in the 
navigation window. The corresponding data window is opened and the 
current setting of the selected binary output is marked.

Assign the required function to the binary output from the dropdown list 
box. The following functions are available: 

SIMEAS Q active With the SIMEAS Q active function, you can monitor whether the device 
is switched on (contact open). If the contact drops out, the device is 
switched off or defective. 

Active work
Reactive work
Apparent work

If you allocate one of these functions to the binary output, the SIMEAS Q 
device always releases a short pulse as soon as the energy value 
specified in the input box has been reached and thus captured by 
SIMEAS Q. 
39SIMEAS Q Par Manual
E50417-H1076-C265-A2

http://siemens-russia.com/


Parameterization
In the input box, specify the energy value which must be reached to 
release a pulse. This function is suitable for energy counting. 

Active power
input / output

If you assign this function to the binary output, the input (contact is open) 
or the output (contact is closed) of active power is displayed.

Threshold 
cos ϕ

If you allocate this function to the binary output, the power factor cos ϕ 
will be monitored. 

Determine a threshold value for the factor. If this factor falls below, the 
contact will close and therefore trigger off an impulse. 
You can use this function as alarm indicator.

Voltage dip If you assign this function to the binary output, a pulse is triggered on a 
voltage dip at this output. 

A voltage threshold parameterized during fault value measurement is 
used as the threshold value. 

You configure this threshold value as follows:

In the navigation window click on Voltage which is located below 
Recording in the event of faults. The data window is displayed. 
Depending on the type of network, you can select up to three phase 
voltages.

Activate the desired phase voltage. The window Enter Threshold is 
displayed.

Determine the necessary thresholds. Hereby, at least one has to be 
below the nominal voltage. 

Confirm with OK.

Out of the maximum of five configurable threshold values for the voltage, 
the highest below the nominal voltage is the threshold value for the 
voltage dip. This function is only available if the Recording in event of 
faults for voltage option has been activated (see above). 

You can use the function as a warning.
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Image4_04.gif

Fig. 4-4   Enter Threshold value window
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4.3.3 Other settings 

Under this item, you can define all the other basic settings for parameter-
izing the SIMEAS Q. 

You select the methods for calculating the flicker interference factors and 
power and the storage mode and define the time and duration of record-
ing as well as the measurement interval for extreme value calculation 
during continuous measurement.

Default settings The default values are shown in Fig. 4-5. 

Image4_05.gif

Fig. 4-5    Basic settings - Other settings data sheet

To make changes, proceed as follows:

Select Other settings under Basic settings in the navigation window. 
The data sheet (Fig. 4-5) is opened in the data window.

Make the necessary settings. In the following, the meaning of the individ-
ual input options is explained in detail.
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Flicker Flicker is a measurement of voltage fluctuations in the low voltage distri-
bution. The term flicker is defined as fluctuating visual perception caused 
by a light stimulus whose luminance or spectral distribution fluctuates 
over time (see IEC 61000-3-3).

Flicker values can be calculated:

by the evaluation indicators Pst and Plt 

by the evaluation indicators Ast and Alt.

(The abbreviations stand for short term and long term). 

Pst or Plt is a measure of the interference effect.

Ast or Alt is a measure of the interference sensitivity.

Select Pst, Plt or Ast, Alt as the method of calculation.

Power calculation For calculation of the power in a three-phase network, you can chose 
between the classic and the expanded method.

Select the classic method if you want to measure in a balanced net-
work, i.e. in a network in which the connected loads are balanced. 
Moreover, no harmonics must occur in the network. 
This mode is preset.

Select the expanded calculation method if you want to measure in an 
unbalanced three-phase system. Harmonics are taken into account in 
the power calculation.

Start and duration 
of recording 

Define from what time and for what period you want to record measure-
ment data.

Select directly to start recording immediately after you have con-
nected SIMEAS Q to the system.

Select from or from ... to and enter the appropriate times to define 
the start of recording and, if necessary, the duration of recording.

Base time For the continuous measuring with extreme values (MIN and MAX), 
specify here a time base for the extreme value capture. Within the 
framework of the extreme value capture, SIMEAS Q stores the average 
value together with the highest and lowest measuring value occurring in 
a measuring period (averaging time). Example:

Note:

Because P values are used to calculate the flicker in the EN 50160 stand-
ard, these values are preset. 

Caution:

Before measuring, check whether the system time of your SIMEAS Q 
has been set correctly. If necessary, correct it (see Chapter 2).
43SIMEAS Q Par Manual
E50417-H1076-C265-A2

http://siemens-russia.com/


Parameterization
Averaging time 1 min; basic averaging time 1 sec. With the beginning of 
each minute, SIMEAS Q starts capturing the 1-minute average value. 
Basic average values are calculated each second (basic averaging time) 
for this purpose. After the measuring period (averaging time), the 1-
minute average value is calculated from 60 basic average values. The 
maximum (MAX) and the minimum (MIN) basic average value are 
determined additionally. The value triple consists of a minimum, a 
maximum and an average value, is saved after each measuring period 
and can be called via the SIMEAS Q Par V2.30. The capture of the next 
value triple for the next minute starts. 

The described procedure is identical for each measured variable 
enabling the capture of extreme values by means of SIMEAS Q. 

You can define different time bases for:

Currents and voltages

all other measured values. 

Save mode 
(Overwriting)

This setting serves to specify if the SIMEAS Q functions as a recorder or 
as a sensor for measured variables. 

Overwriting mode 
not activated

If you select No, SIMEAS Q works as a measured-value recorder. This 
setting must be selected if data shall not be called continuously from the 
SIMEAS Q devices but in very short periods.

Advantage Measured values which have not yet been called by the PC are 
intermediately stored in the SIMEAS Q device. Depending on the 
average time specified, SIMEAS Q has in this case stored several 
measured values of a measured variable (measured-value chain). This 
procedure ensures that no measuring data is lost as long as the capacity 
of the measured value memory is sufficient. 

Note:

The averaging time (parameterized by activating the measured quanti-
ties) must be an integer multiple of the time bases.

Note:

For SIMEAS Q devices with a RS232 interface and with a RS485 inter-
face, this is the case due to the transfer technique. Consequently, you 
must select No for these device types. In this way, all values of a mea-
sured variable to be measured are stored in the memory. These values 
are deleted in the memory to release storage capacity only by the time 
when values (measured value inc. time stamp) are called by the PC.
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Disadvantage As soon as the capacity of the measured-value memory is exhausted, 
SIMEAS Q is unable to save new measured data until storage capacity 
is released again by means of a master station call. Consequently, 
measured data is lost if the data inquiry does not run for a longer period 
of time or if the scan cycle specified is too long.

Overwriting mode 
activated

With the Yes option, SIMEAS Q functions like a sensor. The recording of 
measured-value chains relating to a measured variable is not of primary 
importance in this context. However, this setting is only useful for 
SIMEAS Q devices equipped with a PROFIBUS interface. Due to the 
high transfer rates enabled in this way, current measured values can be 
called from SIMEAS Q in particularly short time intervals of fractions of 
seconds. By means of programmable control systems, these values can, 
for example, be used for control tasks. 

With the Yes option, each stored measured value of a measured variable 
is updated by a newly detected measured value, i.e. the former value is 
overwritten. Consequently, SIMEAS Q does not store a measured-value 
chain in its memory in this case. There is always only one measured 
value per parameter available in the memory.

Advantage A buffer overflow cannot occur.

Disadvantage To record a measured-value chain, it must be ensured that the master 
calls the measured value before this value is updated. If the master 
station does not call the value in the prescribed time, this value is 
overwritten and the former value is lost, i.e. the measured-value chain 
becomes incomplete also in case of very short interruptions of the 
communication between the master and SIMEAS Q. 
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4.4 Activating measured quantities with cont. measurement 

For continuous recording, you define specific measuring periods (aver-
aging times) for each selected measured quantity (except flicker). Using 
the averaging time set, a mean value of the measured quantity is deter-
mined for the acquired current and voltage values and continuously 
stored in the memory with a time stamp. 

In addition, you can acquire the extreme values that occur within a meas-
uring period (averaging time) (time base; see Page 43) and define the 
orders of harmonics that you want to acquire.

Selecting 
measured 
quantities 

To select measured quantities for continuous measurement and to define 
the settings, proceed as follows:

Double-click on Continuous recording in the navigation window. A list 
of all measured quantities that can be acquired continuously is displayed.

Note:

If you want to evaluate the data with SICARO PQ, you have to use the 
averaging time defined in the standard to be used for the evaluation.

It is also allowed to use an integral part of the standard averaging time. 
This affects the memory usage and the operating speed.

Example:
Averaging time according to Standard 10 minutes → 
allowed averaging time 
10 min, 5 min, 2 min, 1 min, 50 s, 40 s, 30 s, 20 s, 10 s. 
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Image4_06.gif

Fig. 4-6 Settable measured quantities for continuous recording

Click on the measured quantity to be activated. The data sheet for this 
quantity is displayed in the data window.

The data sheets for the individual quantities have a similar structure.

The type and number of possible measured quantities depends on the 
selected network type (Basic settings). You can activate measurement 
individually for each phase (if required) and also acquire the sum for 
power measurements.

Let us take an example of a harmonic to explain the inputs (see Fig. 4-7).
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Image4_07.gif

Fig. 4-7 Data window for harmonic voltage for continuous recording

To define or change settings for a measured value, proceed as follows:

Define the averaging time using the dropdown list box (possible range 
1s - 1h). The time applies to all quantities activated in this data sheet.

You activate measurement for the required quantity by clicking on Yes or 
Yes with MIN/MAX. In the latter case, the extreme values of this quantity 
are also acquired. 

In the section for harmonic voltage or harmonic current, you can define 
which harmonics you want measured (up to the 40th order harmonic). 

Note:

The averaging time must be an integer multiple of the time base. For the 
measured quantity Flicker, the averaging time must be specified in the 
calculation algorithm and is not parameterized here. The default averag-
ing time for Flicker short-term is 10 min, for Flicker long-term 120 min.

Note:

You have defined the period for extreme value acquisition as the time 
base (for Basic settings) for currents and voltages or for all other meas-
ured quantities in a standard way.
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Select the individual harmonics (by clicking on them) 

or 

Click on one of the lower buttons to select all, all even, all odd or no 
(none) harmonics.

Caution:

If you click one of these buttons, the previous selection is over written.
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4.5 Activating measured quantities for fault value measure-
ment

With the event-controlled acquisition of measured data, SIMEAS Q cal-
culates an average value over a settable averaging time for each 
selected measured quantity. This average value is compared with set 
threshold values. If values exceed these thresholds and then return to 
normal, measured data is recorded. 

The time and the average measured value so far are recorded. In this 
way, you obtain information about when certain measured quantities 
move out of a nominal range and when they return to it.

You can also define the orders of harmonics to be acquired (up to the 
40th order harmonic).

Selecting meas-
ured quantities 

To select measured quantities for measurement in the event of a fault 
and to define the settings, proceed as follows:

Double-click on Recording in the event of fault in the navigation win-
dow. A list of all quantities for fault value acquisition is displayed:

Image4_08.gif

Fig. 4-8 Settable measured quantities for measurement in the event of a fault

Click on the measured quantity to be activated. The data sheet for this 
quantity is displayed in the data window.

The data sheets for the individual quantities have a similar structure.
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The type and number of possible measured quantities depends on the 
selected network type (Basic settings). You can activate measurement 
individually for each phase (if required) and also acquire the sum for 
power measurements.

Let us take an example of a harmonic to explain the inputs (see Fig. 4-9).

Image4_09.gif

Fig. 4-9 Data window for harmonic voltage for continuous recording

To define or change settings for a measured value, proceed as follows:

Define the averaging time using the dropdown list box. 
The selected time applies to all quantities activated in this data sheet.

You activate measurement of the required quantity by clicking on the 
check box Measurement active. The dialog for defining the threshold 
values is displayed (except for harmonics). 

In the data sheet for harmonic voltage or harmonic current (see Fig. 4-9), 
you can also define which order harmonics you want measured (up to the 
40th harmonic). 

Click on the harmonic to be measured. 

The Enter threshold window is displayed.

Note:

For harmonics, the dialog box for entering the threshold values is only 
displayed if you select the harmonic to be measured. You can define indi-
vidual threshold values for each harmonic.
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Parameterization
Image4_10.gif

Fig. 4-10 Entering threshold values

Enter the threshold values and the associated unit 
(select via dropdown list box).

Confirm with OK.

Note:

If you click on a check box again, the measurements for the selected 
quantities and harmonics are deactivated. The set threshold values 
remain set and are available when activated again.

The number of possible threshold values is not the same for all measured 
quantities. 
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4.6 Transferring parameters 

After you have completed parameterization of the SIMEAS Q, you must 
save the parameter set you created (see Chapter 3). After that, transfer 
the parameters to the SIMEAS Q.

Sending 
parameters 

Please proceed as follows:

Click on Send measurement settings in the Device menu. The param-
eter set is sent to the SIMEAS Q. 

Image4_11.gif

Fig. 4-11 Sending parameters

After that, you can disconnect the device from the power supply and 
install it where it is to be used. After connecting the power supply again, 
the device switches to operating mode after two minutes and starts mak-
ing the parameterized measurements at the defined time. 

Note:

After you have completed the parameterization, you must save the 
parameterization data. See Chapter 3.
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Parameterization
Receiving 
parameters 

Moreover, you can load and modify the current parameter set into your 
parameterization software if the SIMEAS Q is already in operation. 
Please proceed as follows:

Make sure that the connected SIMEAS Q is in parameterization mode. If 
this is not the case, disconnect the device briefly from the network and 
switch it on again.

Send a command within the next two minutes (e.g. with menu item 
Device → Read identification). The device is switched to parameteriza-
tion mode permanently.

Select the command Receive measurement settings in menu item 
Device. The parameter set of the connected SIMEAS Q is read out and 
transferred. 

Now make the necessary changes. After that, you can store the data and 
transfer them to the SIMEAS Q again to update the parameter set.

Image4_12.gif

Fig. 4-12 Receive measurement settings
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4.7 Mounting the device 

You have now prepared and parameterized your SIMEAS Q. Disconnect 
the device from the power supply and from the parameterization compu-
ter. 

Snap the SIMEAS Q onto a mounting rail.

Apply the measuring voltages and currents.

Plug in the connecting cable to the communication processor. 

Connect the power supplies and switch them on. SIMEAS Q is ready for 
measurement and will start recording at the parameterized time.
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Special Functions 5
Overview The following part ’’Special Functions’’ provides information concerning 

calibration and updating the firmware.

Contents 5.1  Calibration  58

5.2  Updating the firmware  61
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Special Functions
5.1 Calibration 

The calibration function is used for optimum setting of the SIMEAS Q to 
the measuring range. SIMEAS Q has been calibrated at 170 V and 3.6 A 
in the factory. These values are approximately in the middle of the meas-
uring range of  to  and  to .

If you have an OMICRON CMS 156 or a similar calibration device, you 
can calibrate the SIMEAS Q yourself. Otherwise, contact your Siemens 
sales representative. 

Calibration 
procedure

You must observe the sequence of the operating steps described below. 
Incorrect calibration causes incorrect measurement results. 

Connect the reference voltages and currents of the calibration device 
with the measurement inputs of the SIMEAS Q.

Connect the SIMEAS Q to the parameterization PC (see Chapter 3.2) 
and start SIMEAS Q Par V2.30 (see Chapter 3.1).

Switch on SIMEAS Q and send a parameterization telegram (see Chap-
ter 3.4).

Start the Calibration function.

100 3⁄ 230V 1 5A

Note:

To keep the measuring accuracy of the SIMEAS Q constant, it is enough 
to calibrate the device every 2 years. You can query the time of last cal-
ibration and the calibrated nominal frequency with the function Receive 
identification.

Caution:

The calibration voltage must be in the range 50 to 280 V, the calibration 
current in the range 1 to 6 A and the nominal frequency has to be 50 or 
60 Hz.

Make sure that the nominal frequency is correct. If the calibrated fre-
quency does not match the frequency of the network to be monitored, the 
measured values will not be correct.
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5.1.1 Performing calibration

Select the menu item Device → Calibrate. The Calibrate dialog box is 
opened.

Image5_01.gif

Fig. 5-1 Calibrating the SIMEAS Q dialog box

Enter the setpoints in accordance with the reference quantities of the cal-
ibration device applied, e.g. 170 V and 3.6 A. 

Click on the Calibrate button to start calibration. An offset calibration and 
an amplitude calibration are performed. SIMEAS Q Parameterization 
guides you step by step.

Follow the instructions in the popup windows and confirm each one with 
OK. 

Image5_02.gif

Fig. 5-2 Offset calibration

Caution:

Check the nominal frequency set on the calibration device. It must match 
that displayed in the Calibrate dialog box. 
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Special Functions
Image5_03.gif

Fig. 5-3 Amplitude calibration

Image5_04.gif

Fig. 5-4 Status message about calibration

Return to the main window with Close.

Disconnect the SIMEAS Q from the calibration device.

Note:

After calibration, SIMEAS Q reboots and is not addressable for approx. 
two minutes.
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5.2 Updating the firmware 

The SIMEAS Q comes with the current firmware from our factory. To acti-
vate new functions or to remove possible errors in the firmware, it is pos-
sible to upload a new firmware with the software SIMEAS Q 
Parameterization.

To update the device firmware please proceed as follows:

Select the menu item Extras → Send firmware. 

Image5_05.gif

Fig. 5-5 Calling up the Send firmware function

The Send firmware dialog box is opened.

Using the Select button, select your diskette drive, mark the firmware file, 
and confirm with Open. The file is placed in the dialog field. After the 
installation of SIMEAS Q PAR you will find the the current device 
firmware in ...\Siemens\SIMEAS_Q_Par\Utilities\Firmware.

Attention:

By uploading a new firmware the data memory in the device will be 
deleted. Read the parameter file about the SIMEAS Q Par software so 
that data are not lost.
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Special Functions
Image5_06.gif

Fig. 5-6 Send firmware dialogue box

After you have selected the firmware file, send the new firmware by 
clicking the button Send Firmware to the SIMEAS Q.

Afterwards a windows will open, showing you the current status of the 
data transmission.

Image5_07.gif

Fig. 5-7 Send firmware dialogue box 

The end of the upgrade will be indicated with a message. Confirm the 
message with OK.

Attention:

Pleas take care, that the selected file has the extension *.B2. Do not use 
any other type of files for an upgrade, otherwise the processor could be 
destroyed.

In case of any doubt please contact our hotline or visit our internet down-
load area www.powerquality.de to get the latest firmware version.

Note:

Due to the transfer rate of 9600 Baud the upgrade of the firmware ca take 
up to 6 minute.
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Image5_08.gif

Fig. 5-8 Send firmware dialogue box

Note:

Please note the information of the read-me file concerning the firmware.
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Quick Reference 6
In this part the necessary steps for configuration and commissioning of a 
SIMEAS Q are listed.

Starting SIMEAS Q Par. Chapter 3.1

Connecting the SIMEAS Q and PC. Chapter 3.2

Setting up the parameterization interface on the PC. Chapter 3.3

Plug-in the auxiliary power supply of SIMEAS Q

Activate configuration mode resp. Receive identification. Chapter 3.4

Setting the device address. Chapter 3.6

Synchronizing the SIMEAS Q. Chapter 3.7

Edit connection settings. Chapter 3.8

Configure measurements settings. Chapter 4

Installation and commissioning of SIMEAS Q. Chapter 4.7
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Formulas and Algorithms A
Overview Appendix A contains the formulas and algorithms that are used to calcu-

late the RMS values and the derived measured quantities.

Contents A.1  Requirements  68

A.2  Current and voltage  68

A.3  Nominal frequency  69

A.4  Power  69

A.5  Flicker  77

A.6  Harmonics of the voltages and currents  78

A.7  Energy (only for continuous recording)  79
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Formulas and Algorithms
A.1 Requirements

The measurement algorithms given below refer to measurements in a 
50Hz system. For 60Hz systems, the formulas must be adapted accord-
ingly.

For measured quantities that are acquired and calculated both during 
continuous measurement and measurement in the event of a fault, the 
formulas and algorithms are identical. Measured quantities that are only 
relevant to one of the two measuring modes are marked accordingly.

A.2 Current and voltage 

SIMEAS Q digitizes the currents and voltages applied with a sampling 
rate of 6,400 Hz in 50Hz networks and 7,680 Hz in 60Hz networks and 
calculates the RMS values from them over half a period. 

Voltage and current values consist of an AC and a DC part. In electrical 
supply systems, the DC component is usually zero and therefore does 
not need to be taken into account.

By definition, the RMS value is the quantity of energy that is converted in 
a purely resistive load.

For voltage and current, the RMS values are calculated as follows:

where

U, Ι RMS values
u, i Measured values for voltage and current
N Number of measured values for 16 periods (here: N = 128 * 16).

UAC
1
N
---- uj

2

j 1=

N

∑
 
 
 
 

= ΙAC
1
N
---- ij

2

j 1=

N

∑
 
 
 
 

=
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A.3 Nominal frequency 

The frequency is always determined at input VP1 of the SIMEAS Q. The 
signal is digitized with sampling frequency fsample, where:

An internal frequency counter measures the sampling rate, i.e. the inter-
nal quartz oscillator determines the accuracy and resolution of the fre-
quency measurement.

A.4 Power 

The power is always calculated for all three phases. Connection of the 
wattmeter is invariable and is defined as follows:

In the case of measurement in a three-wire network, the phase-to-phase 
voltages VP1 - P2 and VP2 - P3 and the currents ΙP1 and ΙP3 are connected to 
the inputs of the SIMEAS Q in a two-wattmeter circuit. Because the volt-
age VP3 - P1 and the current ΙP2 cannot be acquired, no measured quanti-
ties based on them (e.g. harmonic on voltage VP3 - P1) can be acquired. 
Therefore, only the values for the complete system can be acquired for 
the powers.

The device can calculate the power either by the classic or by the 
expanded calculation method. The choice of method depends on the 
conditions in the measuring system.

fsample 128 fnom⋅=

Wattmeter Measured 
quantities

Explanation

W1 P1 ⋅ ΙP1 Phase P1 and current of phase P1

W2 P2 ⋅ ΙP2 Phase P2 and current of phase P2

W3 P3 ⋅ ΙP3 Phase P3 and current of phase P3
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Formulas and Algorithms
A.4.1 Classic calculation 

Here you will find the classic calculation explained generally and using 
the example of a three-wire system.

The measured quantities Vn and Ιn are the RMS values of the fundamen-
tal and the harmonics that the system determines using a fast-Fourier 
analysis.

The calculated quantities apparent power S and reactive power Q refer 
exclusively to the fundamental, because the definitions of these quanti-
ties are only valid for the fundamental.

General explanation

Active power

where

u, i Measured values for voltage and current
N Number of measured values, here: N = 128 * 16.

Apparent power

Reactive power

Power factor

P 1
N
---- uj ij⋅

j 1=

N

∑=

S UAC ΙAC⋅=

Q S2 P2–=

Note:

The sign of the reactive power Q is defined by the phase angle between 
the fundamentals of the voltage and current. If the value is < 0, Q is 
also < 0.

PF P
S
----=
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Polyphase systems
To be able to calculate the power in a three-wire system by the classic 
method, the following conditions must be fulfilled:

Voltage balance

Load balance

No harmonics.

It is possible to apply either the 2-wattmeter method or the 3-wattmeter 
method for the calculation.

2-wattmeter 
method 

For the 2-wattmeter method, the following relations apply:

Total active power

Total apparent power

Total reactive power  

Power factor

Ptotal PW1 PW2+=

Stotal
3

2
------- UP1 P3– IW1⋅ UP2 P3– IW2⋅+( )⋅=

Qtotal Stotal
2 Ptotal

2–=

Note:

The sign of the total reactive power Qtotal is always zero, because the 
positive sequence component in the 3-wire system is not calculated.

PF
Ptotal
Stotal
--------------=
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Formulas and Algorithms
3-wattmeter 
method 

With calculation using the 3-wattmeter method in a 4-wire system, you 
obtain:

Total active power

Total apparent power

Total reactive power  

Power factor

Ptotal PW1 PW2 PW3+ +=

Stotal UP1 UP2 UP3+ +( )2 ΙP1 ΙP2 ΙP3+ +( )2⋅=

Qtotal Stotal
2 Ptotal

2–=

Note:

The sign of the total reactive power Qtotal is the same as the sign of the 
angle difference between the angles of the positive sequence compo-
nents of the voltage and current (see also Unbalanced systems, 
Seite 74).

PF
Ptotal
Stotal
--------------=
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A.4.2 Expanded calculation 

The expanded calculation method is used for power calculation in unbal-
anced networks. 

Unbalanced three-phase systems can be described as 2 symmetrical 
systems with different directions of rotation:

Positive phase-sequence system

Negative phase-sequence system. 

The expanded calculation method is described below using one phase 
and 3-wire systems. After that, the unbalance is calculated in a 3-wire 
system.

Balanced system With the expanded method, the device calculates the characteristic val-
ues of the positive sequence system for apparent power, reactive power 
and phase displacement.

The power calculation for one phase only takes account of the funda-
mental which is indicated in the formulas by the index n = 1. 

Active power

Apparent power

Reactive power

Power factor

Phase displacement

P 1
128
---------- uj ij⋅

j 1=

128

∑=

Sn 1= Un 1= Ιn 1=⋅=

Qn 1= Un 1= Ιn 1=⋅( ) ϕn 1=sin⋅=

PF ϕcos=

ϕn 1= ϕun 1=
ϕin 1=
–=
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Formulas and Algorithms
In 3-phase systems, the device calculates the active power from the 
sum of the individual measurement results of the wattmeters connected:

2-wattmeter method
Sum of the 2 single-phase measurements. The calculation is equivalent 
to the 2-wattmeter method of the classic calculation (see Page A-71).

3-wattmeter method
Sum of 3 single-phase measurements.

Active power

Apparent power

Reactive power

Power factor

where:

pos = positive sequence component of the 3-wire system.

Unbalanced system Unbalance is calculated only in 4-wire systems for the voltages and cur-
rents of the 3 phases. They are defined as the ratio of the balanced sub-
systems Negative sequence system (SubIndex: neg) to the Positive 
sequence system (SubIndex: pos) multiplied by the factor 100%.

Voltage

Current

Ptotal PW1 PW2 PW3+ +=

Stotal 3 U⋅ pos Ιpos⋅=

Qtotal Stotal ϕpos U, ϕpos Ι,–( )sin⋅=

PFtotal ϕpos U, ϕpos Ι,–( )cos=

Usymu

Uneg
Upos
------------- 100⋅=

Ιsymu

Ιneg
Ιpos
----------- 100⋅=
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Positive sequence 
system:

Voltage

From this, the following relation is derived for Uα:

Current Taking the phase angle ϕUI into account, the current values of the posi-
tive sequence system are calculated in a similar way to the voltage val-
ues:

From this, the following relation is derived for Ια:

Uα

Uβ

Uγ

1
3
---

1 e
j2π

3
-------

e
j4π

3
-------

1 e
j4π

3
-------

e
j2π

3
-------

1 1 1

UP1

UP2

UP3

⋅ ⋅

 
 
 
 
 
 
 
 

1
3
---

1 ej 120°⋅ ej 240°⋅

1 ej 240°⋅ ej 120°⋅

1 1 1

UP1

UP2

UP3

⋅ ⋅

 
 
 
 
 
 
 

==

Uα
1
3
--- UP1 ej0o ej0o⋅ ⋅ UP2 e j– 120o ej120o⋅ ⋅ UP3 e j– 240o ej240o⋅ ⋅+ +[ ]⋅

1
3
--- UP1 ej0o⋅ UP2 ej0o⋅ UP3 ej0o⋅+ +[ ]⋅

1
3
--- UP1 0o( )cos j 0o( )sin+( )⋅ UP2 0o( )cos j 0o( )sin+( )⋅ UP3 0o( )cos j 0o( )sin+( )⋅+ +[⋅

1
3
--- UP1 UP2 UP3+ +[ ]⋅

=

=

=

=

Ια

Ιβ

Ιγ

1
3
---

1 e
j2π

3
-------

e
j4π

3
-------

1 e
j4π

3
-------

e
j2π

3
-------

1 1 1

ΙP1

ΙP2

ΙP3

⋅ ⋅ 1
3
---

1 ej 120°⋅ ej 240°⋅

1 ej 240°⋅ ej 120°⋅

1 1 1

ΙP1

ΙP2

ΙP3

⋅ ⋅= =

Ια
1
3
--- ΙP1 ej 0o ϕ±( ) ej0o⋅ ⋅ ΙP2 e j– 120o ϕ±( ) ej120o⋅ ⋅ ΙP3 e j– 240o ϕ±( ) ej240o⋅ ⋅+ +[ ]⋅

1
3
--- ΙP1 ej 0o ϕ±( ) j0o+⋅ ΙP2 e j 120o ϕ±( )– j120o+⋅ ΙP3 e j 240o ϕ±( )– j240o+⋅+ +[ ]⋅

1
3
--- ΙP1 0o ϕ± 0o+( )cos j 0o ϕ± 0o+( )sin+( )⋅

ΙP2 120o ϕ± 120o+–( )cos j 120o ϕ± 120o+–( )sin+( )⋅

ΙP3 240o ϕ± 240o+–( )cos j 240o ϕ± 240o+–( )sin+( )⋅

+

+

[

]

1
3
--- ΙP1 ϕ±( )cos j ϕ±( )sin+( )⋅ ΙP2 ϕ±( )cos j ϕ±( )sin+( )⋅ ΙP3 ϕ±( )cos j ϕ±( )sin+( )⋅+ +[⋅=

⋅=

=

=
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Formulas and Algorithms
Negative sequence 
system: 

Voltage

From this, the following relation is derived for Uβ:

Current

From this, the following relation is derived for Ιβ:

Uα

Uβ

Uγ

1
3
---

1 e
j2π

3
-------

e
j4π

3
-------

1 e
j4π

3
-------

e
j2π

3
-------

1 1 1

UP1

UP2

UP3

⋅ ⋅ 1
3
---

1 ej 120°⋅ ej 240°⋅

1 ej 240°⋅ ej 120°⋅

1 1 1

UP1

UP2

UP3

⋅ ⋅= =

Uβ
1
3
--- UP1 ej0o ej0o⋅ ⋅ UP2 e j– 120o ej240o⋅ ⋅ UP3 e j– 240o ej120o⋅ ⋅+ +[ ]⋅=

Ια

Ιβ

Ιγ

1
3
---

1 e
j2π

3
-------

e
j4π

3
-------

1 e
j4π

3
-------

e
j2π

3
-------

1 1 1

ΙP1

ΙP2

ΙP3

⋅ ⋅ 1
3
---

1 ej 120°⋅ ej 240°⋅

1 ej 240°⋅ ej 120°⋅

1 1 1

ΙP1

ΙP2

ΙP3

⋅ ⋅= =

Ιβ
1
3
--- ΙP1 ej 0° ϕ±( ) ej0°⋅ ⋅ ΙP2 ej 120° ϕ±( ) ej240°⋅ ⋅ ΙP3 ej 240° ϕ±( ) ej120°⋅ ⋅+ +[ ]⋅

1
3
--- ΙP1 ej 0° ϕ±( ) 0°+( )⋅ ΙP2 e j–( ) 120° ϕ±( ) j120°+⋅ ΙP3 e j–( ) 240° ϕ±( ) j240°+⋅+ +[ ]⋅

1
3
--- ΙP1[ 0° ϕ± 0°+( )cos( j 0° ϕ± 0° )+( )sin

ΙP2 120°– ϕ± 240°+( )cos(⋅ j 120°– ϕ± 240° )+( )sin+

ΙP3 240°– ϕ± 120°+( )cos(⋅ j 240°–( ϕ± 120° ) ) ]

1
3
--- ΙP1[ 120°– ϕ±( )cos j 120°– ϕ±( )sin+( )⋅ ⋅ ΙP2 120°– ϕ±( )cos j 120°–( ϕ )±sin+( )⋅+=

+sin+

+

+

+

⋅ ⋅

ΙP3 120°– ϕ±( )cos j 120°– ϕ±( )sin+( ) ]⋅+

=

=

=
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A.5 Flicker 

Flicker is a measure of voltage fluctuations in the low voltage distribution.

In calculating the Flicker parameter, you obtain evaluation indicators that 
indicate the effects of the flicker: 

Pst and Plt are a measure of the interference effect

Ast and Alt are a measure of the interference sensitivity.

The abbreviation st stands for short term, lt for long term.

Short-term:

and

Long-term:

and 

Caution:

For flicker calculations, you do not have to define averaging times, 
because the calculation algorithm for the parameter Flicker defines that 
Pst or Ast is calculated every 10 minutes and Plt or Alt every 120 minutes.

Pst 0 0314. P0 1.⋅ 0 0525. P1s⋅ 0 0657. P3s⋅ 0 28. P10s⋅ 0 08. P50s⋅+ + + +( )=

Ast P3
st=

Note:

The flicker calculation is based on the 250 V lamp model.

Plt
Pstj

3

12
------------

j 1=

12

∑
 
 
 
 

3=

Alt P3
lt=
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Formulas and Algorithms
A.6 Harmonics of the voltages and currents 

SIMEAS Q measures the harmonics up to the 40th order.

The harmonic components are determined by a fast-Fourier analysis of 
the sampled signals (according to IEC 1000-4-7). The amplitude of the 
fundamental and the harmonics up to the 40th order are calculated for 
each current and voltage input. The number of harmonics is defined user-
specifically during parameterization. For voltages, the device determines 
the amplitude values as a ratio to the fundamental as a percentage 
because of the nominal voltage value. The harmonic currents are meas-
ured directly in amperes.

THD The THD factor (Total Harmonic Distortion) is the RMS value of all har-
monics divided by the RMS value of the fundamental of the voltage. 

Voltage

where

n Order of the harmonic

U RMS value of the voltage

THD 0 01.
U1

------------ U2
n

n 2=

40

∑=
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A.7 Energy (only for continuous recording) 

Electrical energy is defined as the power over a certain period. 
SIMEAS Q uses the set averaging time here.  

Active energy EP

Input To calculate the active energy in the input direction, the device integrates 
the positive active power values over the set averaging time.

Output To calculate the active energy in the output direction, the device inte-
grates the negative active power values over the set averaging time.

Caution:

To obtain the correct sign in the following calculations, SIMEAS Q must 
be connected in phase and with the correct direction of power flow.

EP input– Ptotal pos,∑=

where:

Ptotal pos,
0 Ptotal 0≤∧

Ptotal Ptotal 0>∧






=

EP output– Ptotal neg,∑=

where:

Ptotal neg,
0 Ptotal 0>∧

P– total Ptotal 0≤∧






=
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Formulas and Algorithms
Reactive energy EQ

Capacitive To calculate the capacitive reactive energy, the positive reactive power 
values are integrated over the set averaging time; for inductive reactive 
energy, the negative reactive power values.

Inductive To calculate the inductive reactive energy, the negative reactive power 
values are integrated over the set averaging time.

Apparent energy ES To calculate the apparent energy output, SIMEAS Q integrates the 
apparent power values over the set averaging time.

EQ Cap– Qtotal pos,∑=

where:

Qtotal pos,
0 Qtotal 0≤∧

Qtotal Qtotal 0>∧






=

EQ Ind– Qtotal neg,∑=

where:

Qtotal neg,
0 Qtotal 0>∧

Q– total Qtotal 0≤∧






=

ES Stotal∑=
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Standard Parameter File B
Overview The SIMEAS Q Par software is supplied with a standard parameter data 

set. The default values are the mean values of the value ranges recom-
mended in the EN 50160 standard. 

The standard parameter data set is loaded every time the parameteriza-
tion software is restarted. It is named Untitled and is displayed in the title-
bar.

Contents B.1  Basic settings  82

B.2  Measurement settings for continuous measurement  83

B.3  Measurement settings for fault value measurement  86

B.4  Printing out the standard parameter data set  89

B.5  Viewing the standard parameter data set  90
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Standard Parameter File
B.1 Basic settings 

General PC interface COM1

PROFIBUS address 0

Language German

Network 
parameters

Network type Four-wire network

Nominal frequency 50 Hz

Voltage transformer No

Nominal voltage 230 V

Current transformer No

Binary outputs Binary output 1 

Output SIMEAS Q active

Binary output 2 

Output Voltage dip

Basic settings Calculate flicker values as Pst, Plt

Method of power calculation classic

Recording directly

Storage mode not overwriting

Time base for continuous

measurement with MIN/MAX values

for voltage and current 100 ms

for other quantities 1 s
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B.2 Measurement settings for continuous measurement

Voltage V Averaging time 10 min

P1 On

P2 On

P3 On

Current Ι Averaging time 10 min

P1 Off

P2 Off

P3 Off

Frequency f Averaging time 10 min

Frequency Off

Active power P Averaging time 10 min

P1 Off

P2 Off

P3 Off

Total Off

Reactive power Q Averaging time 10 min

L1 Off

L2 Off

L3 Off

Total Off

Apparent power S Averaging time 10 min

P1 Off

P2 Off

P3 Off

Total Off
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Standard Parameter File
Power factor PF Averaging time 10 min

P1 Off

P2 Off

P3 Off

Total Off

Balance current 
and voltage

Averaging time 10 min

Balance voltage On

Balance current Off

Flicker short-term P1 On

P2 On

P3 On

Flicker long-term P1 On

P2 On

P3 On

Harmonic voltage Averaging time 10 min

P1 On

P2 On

P3 On

Harmonic 1st to 40th

Harmonic current Averaging time 10 min

P1 Off

P2 Off

P3 Off

THD Averaging time 10 min

P1 On

P2 On

P3 On
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Energy E Averaging time 15 min

Active energy input EP input Off

Active energy output EP output Off

Reactive energy inductive EQ ind Off

Reactive energy capacitive EQ cap Off

Apparent energy ES Off
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Standard Parameter File
B.3 Measurement settings for fault value measurement 

Voltage V Averaging time 10 ms

P1 On
Threshold 1 207 V (90% of VNom)
Threshold 2 161 V (60% of VNom)
Threshold 3 92 V (40% of VNom)
Threshold 4 23 V (10% of VNom)
Threshold 5 2.3 V (1% of VNom)

P2 On
Threshold 1 207 V (90% of VNom)
Threshold 2 161 V (60% of VNom)
Threshold 3 92 V (40% of VNom)
Threshold 4 23 V (10% of VNom)
Threshold 5 2.3 V (1% of VNom)

P3 On
Threshold 1 207 V (90% of VNom)
Threshold 2 161 V (60% of VNom)
Threshold 3 92 V (40% of VNom)
Threshold 4 23 V (10% of VNom)
Threshold 5 2.3 V (1% of VNom)

Current Ι Averaging time 10 ms

P1 Off

P2 Off

P3 Off

Frequency f Averaging time 10 s

P1 On
Threshold 1 50.5 Hz
Threshold 2 49.5 Hz

Active power P Averaging time 1 s

P1 Off

P2 Off

P3 Off

Total Off

Thresholds All = 0
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Reactive power Q Averaging time 1 s

P1 Off

P2 Off

P3 Off

Total Off

Thresholds All = 0

Apparent power S Averaging time 1 s

P1 Off

P2 Off

P3 Off

Total Off

Thresholds All = 0

Power factor PF Averaging time 1 s

P1 Off
Threshold 1 0.9
Threshold 2 0.8

P2 Off
Threshold 1 0.9
Threshold 2 0.8

P3 Off
Threshold 1 0.9
Threshold 2 0.8

Total Off
Threshold 1 0.9
Threshold 2 0.8

Balance current 
and voltage

Averaging time 1 s

Balance voltage On
Threshold 1 2%
Threshold 2 0%
Threshold 3 0%
Threshold 4 0%
Threshold 5 0%

Balance current Off
87SIMEAS Q Par Manual
E50417-H1076-C265-A2

http://siemens-russia.com/


Standard Parameter File
Harmonic voltage Averaging time 1 s

P1 Off

P2 Off

P3 Off

2nd to 25th harmonic
Threshold 1 according to EN 50160
Threshold 2 Threshold 1 ⋅ 2

Harmonic current Averaging time 1 s

P1 Off

P2 Off

P3 Off

THD Averaging time 10 min

P1 On
Threshold 1 8%
Threshold 2 0%

P2 On
Threshold 1 8%
Threshold 2 0%

P3 On
Threshold 1 8%
Threshold 2 0%
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B.4 Printing out the standard parameter data set 

You can print out the standard parameters.

Proceed as follows:

• Start the SIMEAS Q Parameterization software. The main window is 
opened and the standard parameters are loaded automatically.

• Select the menu item File → Print. The Windows print menu is opened. 
The usual Windows functions can be executed.

• Click on the OK button to start printing.
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Standard Parameter File
B.5 Viewing the standard parameter data set 

To view the standard parameter data set, proceed as follows:

• Start the SIMEAS Q Parameterization software. The main window is 
opened. The standard parameters are loaded automatically.

• Select menu item File → Print preview. You can see the first page of 
loaded parameters. 

• Click on the Enlarge button to read the parameters, and with the Next 
button you can scroll to the next page. 

• With the Print button, you can print out the parameters.

• Click on the Close button to exit the print preview.
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Averaging Times, Time Bases, 
Threshold Values C
Overview To acquire energy values, defined periods are required. If you want sys-

tem messages to be derived from energy values, the corresponding 
threshold values must be defined. SIMEAS Q Par uses the terms aver-
aging time, time base, and threshold value.

In this appendix, the terms are uniquely defined and value ranges are 
listed in a table for the individual parameters of the various recording 
modes.

Contents C.1  Term definitions  92

C.2  Averaging times and time bases (continuous recording)  93

C.3  Averaging times and thresholds (fault value measurement)  95
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Averaging Times, Time Bases, Threshold Values
C.1 Term definitions

Averaging time The averaging time defines the period over which the arithmetic mean is 
calculated from the acquired measured values. 

Depending on the recording mode, SIMEAS Q processes this mean 
value in different ways:

During continuous measurement, the mean value is stored together with 
the time stamp End of measuring period. 

For measurement in the event of a fault, SIMEAS Q compares the mean 
value with one or more thresholds. The device only stores if at least one 
upper or lower threshold has been exceeded.

Time base The time base is only required for continuous recording. It is the period 
over which a measured value is formed from the digitized analog value. 
A largest and a smallest value is filtered out of these measured values to 
determine the extreme values of a measured quantity within the averag-
ing time.
The time base must be an integer part of the averaging time. 

Threshold value Threshold values are user-specifically parameterized limit values for 
acquisition in the event of a fault. The system requires at least one 
threshold value for each measured quantity. A measured quantity is only 
acquired if at least one upper or lower threshold value is exceeded.
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C.2 Averaging times and time bases (continuous recording)

If you parameterize SIMEAS Q for continuous recording of measured 
values, you can select different averaging times for the measured quan-
tities. The system requires the time bases to acquire extreme values. 

Table C-1 Averaging times and time bases with reference to the measured quantity for continuous 
recording

Measured value Averaging times Time bases for extreme value 
acquisition

RMS values phase-ground 
voltages or phase-phase 

voltages

1, 2, 5, 6, 10, 15, 30 s
1, 2, 5, 6, 10, 15, 30, 60 min

for 50Hz nominal frequency
20, 40, 60, 80, 100, 120, 140, 
160, 180, 200, 500 ms,
1, 2, 5, 6, 10, 15, 30 s
1 min

for 60Hz nominal frequency
16, 33, 50, 66, 83, 100, 116, 
133, 150, 166, 183, 200, 
500 ms,
1, 2, 5, 6, 10, 15, 30 s,
1 min

RMS value phase currents

Nominal frequency 1, 2, 5, 6, 10, 15, 30 s
1 min

Active power 
(per phase and total)

Reactive power 
(per phase and total)

Apparent power 
(per phase and total)

Power factor 
(per phase and total)

Balance current and 
voltage

Flicker interference factor 
short-term

10 min

Flicker interference factor 
long-term

120 min
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Averaging Times, Time Bases, Threshold Values
1st to 40th harmonic 
voltage per phase

1, 2, 5, 6, 10, 15, 30 s
1, 2, 5, 6, 10, 15, 30, 60 min

1, 2, 5, 6, 10, 15, 30 s
1 min

1st to 40th harmonic 
current per phase

Total harmonic distortion 
THD per phase

Active energy - input
Active energy - output

Reactive energy - 
inductive

Reactive energy - 
capacitive

Apparent energy

1, 2, 5, 6, 10, 15, 30, 60 min

Table C-1 Averaging times and time bases with reference to the measured quantity for continuous 
recording

Measured value Averaging times Time bases for extreme value 
acquisition
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C.3 Averaging times and thresholds (fault value measurement)

The averaging times for measurements in the event of a fault are deter-
mined independently of the averaging times for continuous recording. In 
addition, at least one threshold value must be defined for each measured 
quantity.

Table C-2 Averaging times and threshold values for recording in the event of 
a fault

Measured value Averaging times Number 
of thres-

holds

RMS values 
phase-ground voltages 

or 
phase-phase voltages 

for 50Hz nominal frequency
10, 20, 50, 100, 500 ms,
1, 2, 5, 6, 10, 15, 30 s,
1, 2, 5, 6, 10, 15, 30, 60 min

for 60Hz nominal frequency
8, 16, 33, 50, 66, 83, 100, 
116, 133, 150, 166, 183, 
200, 500 ms,
1, 2, 5, 6, 10, 15, 30 s,
1, 2, 5, 6, 10, 15, 30, 60 min

5

RMS value phase 
currents

Nominal frequency 1, 2, 5, 6, 10, 15, 30 s
1, 2, 5, 6, 10, 15, 30, 60 min

2

Active power 
(per phase and total)

Reactive power 
(per phase and total)

Apparent power 
(per phase and total)

Power factor 
(per phase and total)

Balance current and 
voltage

5
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Averaging Times, Time Bases, Threshold Values
1st to 40th harmonic 
voltage per phase

1, 2, 5, 6, 10, 15, 30 s
1, 2, 5, 6, 10, 15, 30, 60 min

2 per 
harmonic

1st to 40th harmonic 
current per phase

Total harmonic distortion 
THD per phase

2

Table C-2 Averaging times and threshold values for recording in the event of 
a fault

Measured value Averaging times Number 
of thres-

holds
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Glossary 

Ast, Alt A measure of interference sensitivity (st = short term; lt = long term)

Averaging time The averaging time is a multiple of the → time base. Extreme values are 
calculated over the averaging time.

Balanced system Polyphase network in which all phases are loaded evenly with loads

Binary outputs Output of binary signals (high and low) to switch relays.

Byte Unit of information consisting of 8 bits (octet).

Checkbox Are used to activate and deactivate functions. More then one checkbox 
in a group can be active at the same time.

Classic method Algorithm for calculating power in a → balanced system without taking 
the harmonics into account.

Continuous 
recording

Continuous recording of the measured quantities in a user-specifically 
defined time base.

Converter Adapter for connecting different standardized interfaces.

cos ϕ Power factor

Data window Window for entering data.

Expanded method Algorithm for calculating power in an → unbalanced system taking the 
harmonics into account.

Fault value 
recording

Only measured values that exceed user-defined → threshold values are 
stored. They are stored with a timestamp.

Flicker Measure of voltage fluctuations in the low-voltage distribution.
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Glossary
FT Abbreviation of file transfer

Gender Changer An adapter allowing connection of two connectors with the same gender.

GSD file Geräte-Spezifische Datei = device-specific file

Master Higher-level device that monitors and controls lower-level devices 
(→ slaves).

Navigation window Forms the program structure of the measurement settings. By clicking or 
double-clicking on the structure icons you can "navigate" between the 
various parameter groups and dialog boxes.

Negative sequence 
component

Polyphase system in which the phases P1, P2, and P3 are offset coun-
terclockwise by 120°.

Parameter 
numbers

→ PNU. Part of the unique designation of the measured quantities. The 
identifier consists of the PNU and → subindex.

PNU → Parameter numbers

Positive sequence 
component

Polyphase system in which the phases P1, P2, and P3 are offset clock-
wise by 120°.

Pst, Plt A measure of interference effect (st = short term; lt = long term).

Radio button Are used to activate and deactivate functions. Only one radio button in a 
group can be active at any one time.

SIMEAS Q SIemens MEASuring Quality

Network quality recorder

SIMEAS Q 
parameterization

Parameterization software for SIMEAS Q.

Slave Lower-level device that is monitored and controlled by a higher-level 
device ( → master).

sql file Extension for parameter files

Standard 
parameter set

Parameter data set preset in the factory in the SIMEAS Q and in 
SIMEAS Q parameterization.
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Glossary
SU Daylight-saving/standard time switchover

subindex Part of the unique designation of the measured quantities. The identifier 
consists of the → PNU and subindex.

THD Total harmonic distortion

Threshold value Limit value that triggers and action, e.g. status message, warning, shut-
down, etc. For a measured quantity, it is possible to define several 
threshold values that trigger classified actions.

Time base Time in which a mean value is formed from the sampling values. These 
mean values are used to calculate extreme values over the → averaging 
time.

Time information Date and time of an event.

Time stamp → Time information

Unbalanced 
system

Polyphase network in which not all phases are loaded evenly with loads.

Validity The validity bit indicates the status valid or invalid.
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Index

Numerics
3 wire network - Delta  4-37
4 wire network - Star  4-37

A
Activating measured quantities

continuous measurement  2-6,  4-46
fault value measurement  4-50

Algorithm
nominal frequency  1-69

Algorithms
2-wattmeter method  1-71
3-wattmeter method  1-72
balanced systems  1-73
current  1-68
energy  1-79
ff.  1-67
Flicker  1-77
harmonics  1-78
negative sequence system  1-76
power classic  1-70
power modern  1-73
THD  1-78
total harmonic distortion  1-78
unbalanced systems  1-74
voltage  1-68

Assembling the parameterization cable  3-17
Averaging time

fault value measurement  1-95
recording continuous  1-93

Averaging times
definition  1-92
ff.  1-91

B
Base time  4-43
Basic settings

binary outputs  4-39
default settings  1-82
defining  4-36
network settings  4-37
other settings  4-42

Binary outputs  4-39

default setting  4-39
functions  4-39

C
Calculating the measured data  4-32
Calculation of the measured data  4-32
Calibration  5-58
Calling up data sheets  4-34
Checking parameterization  3-29
Connecting cable

PC - SIMEAS Q  3-17
Connecting the parameterization cable  3-18
Connecting the parameterization PC  3-17
Continuous measurement

activating measured quantities  2-6,  4-
46

selecting measured quantities  4-46
Continuous recording  4-32

averaging time  1-93
time base  1-93

Current
formulas  1-68

D
Data group  4-35
Data sheets

calling up  4-33
general  4-35

Default parameters  1-81
Default settings

binary outputs  4-39
others  4-42

E
Energy

formulas  1-79
Enter threshold  4-51
Entering

measurement settings  4-34
Entering measurement settings  4-34

F
Fault value measurement
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Index
activating measured quantities  4-50
averaging time  1-95
selecting measured quantities  4-50
threshold values  1-95

Firmware  5-61
updating  5-61

Flicker  4-43
formulas  1-77

Formulas
2-wattmeter method  1-71
3-wattmeter method  1-72
balanced systems  1-73
classic power  1-70
current  1-68
energy  1-79
ff.  1-67
Flicker  1-77
harmonics  1-78
negative sequence system  1-76
nominal frequency  1-69
power modern  1-73
THD  1-78
total harmonic distortion  1-78
unbalanced systems  1-74
voltage  1-68

Function test  3-29
Functions binary outputs  4-39

H
Harmonics

formulas  1-78

M
Measured quantities

overview  4-33
Measurement settings

parameterizing  4-32
Measurement settings continuous

default settings  1-83
Measurement settings fault value measure-

ments
default settings  1-86

Menu
Device  3-11
Extras  3-12
File  3-11
Help  3-12
View  3-12

Mounting am Messort  4-55
Mounting the SIMEAS Q am Messort  4-55

N
Navigation window  4-34
Network settings  4-37
Netzparameter

Voreinstellung  4-37
Nominal frequency

formulas  1-69

O
Other settings  4-42

base time  4-43
default setting  4-42
Flicker  4-43
power calculation  4-43
Save mode  4-44
start and duration of recording  4-43
storage mode  4-44

P
Parameter file

receiving  4-54
sending  4-53
transferring  4-53

Parameterizing measurement settings  4-32
Parameterizing SIMEAS Q  2-3,  4-31
Power

2-wattmeter method  1-71
3-wattmeter method  1-72
balanced systems  1-73
classic calculation  1-70
modern calculation  1-73
negative sequence system  1-76
unbalanced systems  1-74

Power calculation  4-43
Procedure

calibration  5-58
PROFIBUS DP system

assigning the address  3-23,  3-25

R
Receiving

parameter file  4-54
Recording

continuous  4-32
faults  4-32

Recording in the event of faults  4-40
Recording of faults  4-32
Requirements for the Hardware  2-5
Requirements for the Software  2-4

S
Save mode  4-44
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Index
Selecting measured quantities  4-46
fault value measurement  4-50

Selecting the language of the user interface  
3-13,  3-14

Sending
parameter file  4-53

Service and maintenance
ff.  5-57

Setting the PROFIBUS address  3-23,  3-25
Setting up the parameterization interface  3-

19,  3-20,  3-21
SIMEAS Q

calibration  5-58
function scope  1-1

SIMEAS Q Parameterization
calling up data sheets  4-34
call-up  3-8
data area  3-10
data group  4-35
Device menu  3-11
entering measurement settings  4-34
exiting  3-8
Extras menu  3-12
File menu  3-11
getting started  3-7
Help menu  3-12
main menus  3-11
menu bar  3-9
navigation window  4-34
selecting the language of the user 

interface  3-13,  3-14
setting up the parameterization interface  

3-19,  3-20,  3-21
status bar  3-10
title bar  3-9
tool bar  3-10
user interface  3-9
View menu  3-12

SIMEAS Q parameterization
introduction  1-1

Sonstige Einstellungen  4-39,  4-41
Standard parameter file

basic settings  1-82
ff.  1-81
measurement settings continuous  1-83
measurement settings fault value 

measurements  1-86
printing out  1-89
viewing  1-90

Start and duration of recording  4-43
Storage mode  4-44

T
THD

formulas  1-78
Threshold values

definition  1-92
fault value measurement  1-95
ff.  1-91

Time base
recording continuous  1-93

Time bases
definition  1-92
ff.  1-91

Total harmonic distortion
formulas  1-78

Transferring
parameter file  4-53

U
Updating

firmware  5-61

V
Voltage

formulas  1-68
Voreinstellungen

Netzparameter  4-37

W
With transformer option  4-38
Without transformer option  4-38
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Siemens AG

PTD EA D SC 22

Postfach 4806

D-90026 Nürnberg

From:

Your name : ................................................................................................

Your title : ................................................................................................

Yourcompany : ................................................................................................

Department : ................................................................................................
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City, State : ................................................................................................
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Fax : ................................................................................................

Please tick your area of work:

Other

Automation

Mining (incl. strip mining)

Chemical industry

Power generation

Power distribution, power system 
management

Gas/water/sanitary utilities

Building services, air conditioning

Heavy machine construction, 
handling systems

Pipelines

Shipbuilding, navigation

Environmental technology

Traffic and transportation
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Please answer the following questions by giving a rating between 

1 = good 5 = poor.

1. Does the contents cover your requirements? ...........

2. Could you spot the information you need without any problems? ...........

3. Did you find the texts easy to understand? ...........

4. Does the information depth meet your requirements? ...........

5. How do you judge the quality of the illustrations? ...........

If you have encountered any concrete problems, please give us a concise 

description:

............................................................................................................................

............................................................................................................................

............................................................................................................................

............................................................................................................................

............................................................................................................................

............................................................................................................................

............................................................................................................................

............................................................................................................................

............................................................................................................................

............................................................................................................................
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